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Executive Summary 

This work is motivated by the IPCC climate forecast which states that carbon dioxide levels will increase 

to 550 ppmv by 2050. It is uncertain how forest ecosystems will respond to increases in carbon dioxide, 

what the potential for further carbon storage in forest ecosystems is, and how much these ecosystems can 

ameliorate anthropogenic carbon dioxide emissions. Previous research has yielded inconclusive answers 

to these questions, although certain trends began to emerge. For example, increases in atmospheric carbon 

dioxide allowed stands of several species to support higher leaf area index (e.g., aspen, birch and pine), 

while others (e.g., sweetgum) have shown a decline. 

This work covers the last four years of the Free-Air Carbon Dioxide Enrichment (FACE) experiment 

conducted in the Blackwood Division of the Duke Forest. The experiment involved elevating carbon 

dioxide levels in four of the eight plots to +200 ppmv over ambient conditions during the first two of the 

four years (the last years of enrichment at the site), followed by two years under ambient CO2. During the 

experiment, 11.2 g/m2 nitrogen fertilization was added annually to half of each plot to determine effects 

of carbon dioxide enrichment based on site quality, which was moderately poor under native soil 

condition, and fertile with nitrogen addition. Species examined within the FACE site include loblolly 

pine, sweetgum and other broadleaved deciduous species. The working hypothesis was that leaf area 

index was enhanced by current year photosynthesis and is, therefore, dependent directly on carbon 

dioxide levels. 

The methods employed to determine the effects of carbon dioxide on these species involved the collection 

of litter-fall monthly from January to September, and biweekly from October through December. The 

litter-fall thus collected was dried, sorted to species and weighed to obtain dry leaf mass. Further 

processing allowed estimation of fascicle sheath mass to total fascicle mass ratio, to facilitate removal 

from the former to estimate leaf area index, and a ratio of leaf area per mass to facilitate conversion of 

mass to area. Following, the seasonal dynamics of leaf area index were reconstructed using equations 

generated from Kinerson, et al. (1974) for loblolly pine, and Oren and Pataki (2001) for broadleaved 

deciduous species.  Analysis of the data was performed on leaf area index enhancement ratios, to 

determine the effect of carbon dioxide on leaf area index on both moderate and high fertility sites. 

Results showed that specific leaf area in pine does not respond to CO2 concentration, while that of 

broadleaved deciduous species is likely to be higher in the future. In contrast, loblolly pine litter-fall mass 

trended to be higher under elevated CO2, but that of broadleaved deciduous species was unaffected. The 

combined effect of these responses was to pine leaf area index under elevated atmospheric CO2, as well as 

the index of the entire canopy, were influenced directly by current year’s carbon dioxide levels. However, 

owing to greater variability relative to the mean, the enhancement of sweetgum leaf area index and that of 

other broadleaved deciduous species were not so clearly related to CO2 enrichment. Loblolly pine leaf 

area index was increased 15% on moderate fertility sites and 7% on high fertility sites, while total canopy 

increased 13% on both moderate and high fertility sites. Interpretation of the results was further 

complicated by drought conditions in 2009, which affected the estimates of broadleaved deciduous 

species, creating an underestimation in the same year. Due to needle longevity, the drought-induced 

overestimates in 2009 created a corresponding underestimation of pine leaf area index in 2010. 

In conclusions, leaf area index of pine plantations on moderate fertility sites will continue to be 

influenced strongly by pine species even where broadleaved deciduous competition is not controlled. 

However, leaf area index on high fertility sites will become dominated earlier or to a greater extent by 

competing broadleaved deciduous species.   
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Introduction  

Forests contain several long-term carbon storage pools, including the soil carbon and carbon of 

woody biomass. The rate at which carbon is released back to the atmosphere is controlled by 

animals, insects, and fungi respiration during the decomposition of the various pools (Brady and 

Weil, 2007). Although the amount of foliage determine stand-scale photosynthesis, some of 

which ends up in carbon pools with long residence time, the residence time of carbon invested in 

foliage (as well as fine roots) is rather short. However, Leaf Area Index (LAI), a unit-less 

measure of the area of leaves overlaying a given ground area, exerts a strong influence on stand 

growth by controlling the production of carbohydrates, the photosynthetic chemical reaction that 

is driven by sunlight absorbed by the leaves (Burton, Zak, Denton and Spurr, 1998). The index is 

measured in forests to determine the potential sunlight interception and photosynthesis which are 

related to growth rates.    

 McCarthy, et al. (2007) assessed the effects CO2 enrichment had on Pinus taeda (L.) 

(loblolly pine) LAI, showing an increase of LAI under both native and fertilized soil conditions. 

Results from other experiments showed contrasting responses (Bader, Siegwolf and Körner 

2010; Cheng, et al. 2014; Herrick and Thomas 1999, 2003; Liberloo, et al. 2006; Newingham, et 

al. 2013; Norby, et al. 2003; Riikonen, et al. 2008; Uddling, et al. 2008). Published CO2-induced 

enhancement ratios of leaf mass, specific leaf area (SLA) and LAI are presented in the Appendix 

(Table 1). Liquidambar styraciflua (L.) (sweetgum) has been shown to decrease LAI under 

increasing atmospheric CO2 (Cheng, et.al. 2014; Herrick and Thomas, 1999, 2003; Warren, 

Norby and Wellshlager 2011). Other broadleaved deciduous species showed mixed results 

possibly due to physiological differences between species (Bader, Siegwolf and Körner 2010; 

Liberloo, et al. 2006; Norby, et al. 2003). Like loblolly pine, Populus tremuloides (L.) (American 

aspen) and Betula papyrifera (L.) (American white birch) have shown positive LAI enhancement 
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under increasing atmospheric CO2, possibly related to increased carbohydrate availability 

(Newingham, et al. 2013; Riikonen, et al. 2008; Uddling, et al. 2008), with increases associated 

with higher litter-fall mass but not SLA.   

 The Free-Air CO2 Enrichment experimental sites (FACE) experiment was designed to 

provide forest managers and government officials with information regarding the relative 

capacity of forests to store additional carbon. The focus was on determining forest effectiveness 

in storing additional carbon under projected increases of atmospheric carbon-dioxide, thus 

ameliorating anthropogenic CO2 emissions. One of the FACE studies was located in the 

Blackwood Division of the Duke Forest. The Duke FACE experiment was conducted to 

determine the effects of increasing atmospheric concentrations of CO2 on tree growth and 

ecosystem carbon sequestration on relatively infertile sites (McCarthy, et.al. 2007), and where 

fertility was enhanced through nitrogen (N) fertilization. A +200 ppmv enrichment over ambient 

atmospheric CO2 levels during daylight hours was chosen based on increases projected to 2050.  

 This work examines the effects of elevated atmospheric CO2 on one major ecosystem 

property, LAI of planted loblolly pine and broadleaved deciduous species located within the 

eight 30 m diameter plots of the FACE site, utilizing the last two years of 15-17 year-long CO2 

enrichment, and the first two years post enrichment. Given that the broadleaved species replace 

leaves annually, I hypothesized that their contribution to stand LAI will return to that in 

unenriched plots the year following the termination of CO2 enrichment, but that because loblolly 

pine foliage longevity averages 18 months, its contribution to LAI will take longer to return to 

ambient. Alternatively, LAI-enhancement may be related to long-term processes of plant 

hydraulics or nutrient cycling, thus delaying the return to ambient, or to current photosynthesis, 

and thus hastening the return to ambient LAI to soon after termination of CO2 enrichment.   
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Methods 

Site description 

The Duke FACE study site consisted of loblolly pine planted in 1983. The climate for this region 

of North Carolina is of warm humid summers and mild winters, mean annual temperatures is 

15.8 °C, and annual rainfall average 1145 mm. The soil is of the Enon Series which are low 

fertility, acidic clay-loam. Pine has predominated the canopy and site, with broadleaved 

deciduous species comprising the mid- and understory. The most prevalent broadleaved 

deciduous species on the site is sweetgum.  

 The experiment was a randomized block design for CO2 enrichment with 4 paired plots, 

and a split plot design after nitrogen fertilization was implemented. Nitrogen fertilization was 

added to determine if increased carbon storage could be achieved on higher fertility sites.  

 In 1994 the first pair of plots was established, with the remaining three pairs of plots 

established in 1996 (McCarthy, et.al. 2007). The four control plots remained at ambient carbon 

dioxide levels, while the four experimental plots received a regulated 200 ppmv increase of 

carbon dioxide over ambient levels (Oren, 2012). In 1998 a single control plot and experimental 

plot were split in half with one half receiving annual nitrogen fertilization (11.2 g/m2 of N). The 

remaining plots were split in half in 2005 with one half of each plot receiving annual nitrogen 

fertilization (McCarthy, et.al. 2007). Nitrogen fertilization and carbon dioxide enrichment for all 

plots was stopped at the end of 2010.  

 

Litter-fall Collection Procedures 

Litter-fall was collected monthly from February-September and twice monthly from October-

January throughout each year of the study. Some litter collection dates were not met due to 
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inclement weather. The litter-fall was collected using three (0.16 m2) litter baskets in each plot 

quadrant and combined into a single (0.48 m2) sample per quadrant (Oren, 2009a). Litter-fall 

consisting primarily of pine needles, sweetgum leaves and other broadleaved deciduous leaves 

combined, was dried (65°C, 4 days), sorted, weighed and recorded. 

 

Calculating Specific leaf area 

Subsamples of the litter-fall were measured using the imageJ program (Oren, 2009b) to obtain 

leaf area, dried and weighed.  Specific Leaf Area (SLA cm2/g) is calculated as leaf area divided 

by leaf mass based on sub-samples taken at each litter collection time. ANCOVA analysis was 

conducted in R to compare values across treatments (randomized block design for CO2 and a 

split-plot for N fertilization) for each species groups. Sweetgum (p = 0.0142) and broadleaved (p 

< 0.0001) differed among CO2 X N treatments, while loblolly pine did not (p = 0.138).  

 

Removal of Fascicle Sheath Mass 

Estimating loblolly pine leaf area from mass required the removal of fascicle sheath mass from 

total pine litter-fall mass. The percentage of fascicle sheath mass for each treatment was 

calculated by dividing the fascicle sheath mass by the combined fascicle sheath and needle mass 

from the SLA subsamples. The resultant values were analyzed using ANCOVA in R to test for 

treatment effects; none were found (p = 0.3456).  Fascicle sheath percentage was averaged over 

all treatments and multiplied by total pine litter-fall mass to obtain the needle mass contributing 

to LAI. 

 

Obtaining Mean Treatment Values 
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In the fall of 2010, half of each split-plot treatment was harvested, requiring that the post-harvest 

value of each split-plot treatment is corrected for differences between the harvested and residual 

portions. The correction was based on relationship between litter-fall mass of the entire plot-half 

2009-2010 of each split-plot treatment, and the quarter that was not harvested later. The 

equations were used to correct 2011-2012 data in order to have a consistent value across years. 

Once litter-fall for each species was corrected for the effect of the harvest, data were examined 

for outliers.       

 

Calculating Leaf Area Index 

Pine LAI was calculated using Kinerson (1974) and the Sampson (2003) formulas for needle 

elongation and needle abscission. These formulas provide the relative LAI change for each 

period; for Kinerson (1974) this is calculated daily, for Sampson (2003) this is calculated 

monthly. Sampson’s predicted values were interpolated to predict daily values of LAI dynamics 

for combination with Kinerson’s values. In order to obtain LAI values for the year the relative 

change were multiplied by the annual needle litter-fall mass.  Because needle elongation and 

abscission rates change among years, the ability to predict LAI depends on how similar the 

weather of the study years is to that during which the formulas were generated. 

 Sweetgum and broadleaved species LAI were calculated using the Oren and Pataki 

(2001) formula for leaf expansion. Broadleaved leaf expansion began after reaching 427 degree 

days following the last period of four or more days of zero degree days for each year. This varied 

leaf expansion start dates across the years from March 7th to April 5th. This formula provides the 

relative leaf expansion calculated over a 30 day period following the methods in McCarthy 

(2007).  Leaf senescence was calculated by removing the litter-fall collections from the total 
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annual litter-fall. The litter-fall values were further modified to predict daily time intervals for 

LAI change. 

 

Data Analyses 

 The enhancement ratio of LAI, the ratio by which CO2 increased LAI in unfertilized and 

fertilized sites, was calculated for each plot pair by dividing the elevated CO2 plot LAI by the 

control plot LAI, for fertilization treatment. The plots at the Duke FACE site were paired based 

on similarity of basal area and soil properties as: 1&2, 3&5, 4&6 and 7&8. One-tailed t-tests 

were conducted in each of the two enrichment years to assess the significance of a positive CO2 

effect, while post-enrichment years were examined using two-tailed t-tests, as there was an 

expectation of no effect.  

 

 Results and Discussion 

 Relationships between leaf litter-fall in half-plots and the quarter-plot selected as post-

harvest residual based on data from the two years prior to harvest were used to correct for spatial 

differences. These relationships had R2
 values ranging 0.39-0.99 for sweetgum, 0.62-0.97 for 

other broadleaved deciduous species, and 0.85-0.98 for loblolly pine.  

 Fascicle sheath mass represented 0.086 to 0.093 % of the total sample mass. Each species 

SLA and litter-fall mass (Appendix: Figures A1) were examined intra-annually and inter-

annually for trends, as was fascicle sheath mass percent. Loblolly pine SLA and fascicle sheath 

percent remained consistent across all years, while its litter-fall mass, sweetgum SLA and litter-

fall mass, other broadleaved deciduous species SLA and litter-fall mass varied among years.  A 

noticeable decrease in sweetgum and other broadleaved deciduous species SLA was found with 
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doubling of leaf mass per area post enrichment. 

 

Leaf Area Index 

 Maximum, mean and minimum LAI values (Appendix: Table 2) were calculated on an 

annual basis for loblolly pine, sweetgum, and other broadleaved deciduous species.  Comparing 

the LAI values for each species in the control plots during periods of CO2 enrichment and post-

enrichment revealed relatively stable LAI for both loblolly pine and sweetgum, while LAI of the 

other broadleaved deciduous species tended to decline. 

 Pine LAI values were increased with CO2 (Appendix: Table 2).  Under elevated CO2, 

sweetgum LAI values tended to decrease below those of the ambient conditions in fertilized plots 

but increased under native soil fertility (Appendix: Table 2).  The LAI of other broadleaved 

deciduous species tended to increase in fertilized plots and decreased when only CO2 was 

enriched (Appendix: Table 2). 

 The enhancement ratio of LAI was significant for loblolly pine and the entire canopy 

during the enrichment years with increased responses of 15% and 13% on native fertility soils 

and 7% and 13% in fertilized plots, respectively (Figures 1 and 2), complicated by drought 

conditions in 2009.  The year following the termination of CO2 enrichment, loblolly pine on both 

moderate and high fertility plots returned to ambient CO2 LAI.  Total canopy LAI declined 

below ambient conditions in high fertility plots due to a large broadleaved deciduous component 

LAI, while in moderate fertility sites broadleaved deciduous species are less dominant. 

 The LAI enhancement ratio of sweetgum and other broadleaved deciduous species during 

the two enrichment years did not reveal clear tendencies for Sweetgum or other broadleaved 

deciduous species regardless of soil fertility (Figures 1 and 2), complicated by the drought in 
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2009, species competition and background variance.  These complications are evident in the 

post-enrichment period for both sweetgum and other broadleaves. 
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Enhancement Ratio of Leaf Area Index on Moderate Site Fertility 

  
 

  
 

       
Figures 1: Leaf area index enhancement ratio due to CO2 enrichment in moderate soil fertility of 

sweetgum (A), other broadleaved deciduous species (B), loblolly pine (C), combined 

broadleaved deciduous species (D), and the entire canopy (E).  Values shown are P-values from 

one-tailed t-test for 2009-2010 (Enrichment Period), and two-tailed t-test for 2011-2012 (Post-

Enrichment Period).  Horizontal green line indicates long-term enhancement for loblolly pine, 

while horizontal red line indicates the-long term enhancement for the canopy, both from 

McCarthy, et.al. (2007). Horizontal black lines represent anticipated result for no effect. Error 

bars represent one standard error. 
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Enhancement Ratio of Leaf Area Index on High Site Fertility 

 

  
 

  
 

 
Figures 2: Leaf area index enhancement ratio due to CO2 enrichment in high soil fertility of 

sweetgum (A), other broadleaved deciduous species (B), loblolly pine (C), combined 

broadleaved deciduous species (D), and the entire canopy (E).  Values shown are P-values from 

one-tailed t-test for 2009-2010 (Enrichment Period), and two-tailed t-test for 2011-2012 (Post-

Enrichment Period).  Horizontal green line indicates long-term enhancement for loblolly pine, 

and horizontal red line indicates the-long term enhancement for the canopy, both from McCarthy, 

et.al. (2007). Horizontal black lines represent anticipated result for no effect. Error bars represent 

one standard error.  
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In accordance with the alternative hypothesis, both the contribution of loblolly pine to LAI and 

LAI of the entire canopy return to that of the ambient conditions the year following the 

termination of CO2 enrichment, regardless of soil fertility. Although the data for sweetgum and 

other species was too variable to be useful for testing the hypotheses, the similarity of the pine 

and canopy responses, and the fact that broadleaved deciduous species comprised a large 

proportion of canopy LAI (Appendix: Figure A1) suggest that indeed all species are dependent 

on currently produced carbohydrates to support higher LAI under CO2 enrichment. Below I 

discuss the response of each species and group of species. 

 Previous results from FACE experiments revealed a slight decrease of sweetgum LAI 

under higher CO2 (Cheng, et al. 2008, Herrick and Thomas, 1999, 2003; Norby, et al. 2003).  

This study did not support this pattern (Fig. 1A and 2A). However, sweetgum LAI tended to rise 

post-enrichment, suggesting that CO2 enrichment may have held the LAI of this species lower 

than its potential. Other broadleaved deciduous species did not respond under higher CO2 on 

native soil fertility (Fig. 1B and 2B). Under fertilized conditions, however, an insignificant 

reduction of LAI followed the termination of enrichment. Previous results from FACE 

experiments have corroborated these trends (Bader, Siegwolf, and Körner, 2010; Liberloo, et al. 

2006; Riikonen, et al. 2008; Uddling, et al. 2008).  

 The combination of all broadleaved deciduous LAI reveals two distinct trends based on 

species interactions for each site. Moderate fertility sites reveal no obvious response to elevated 

CO2 (Fig. 1D), suggesting other limiting factors such as nutrient availability or species 

competition controlled LAI. High Fertility sites showed a tendency for higher LAI of 

broadleaved deciduous species under enrichment, and a decrease after termination (Fig. 2D).   

 Effects of carbon dioxide enrichment on loblolly pine showed an increase in LAI on both 
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moderate and high fertility sites, with a 15% and 7% increase, respectively (Fig. 1C and 2C).  

These results are similar to published responses (McCarthy, et al, 2007; Newingham, et al. 

2013), revealing a strong tendency for pine species to increase LAI under increasing atmospheric 

CO2.  Post-enrichment the LAI values on both sites returned within the year to ambient CO2 

values.  The results were complicated by a drought in 2009 which artificially increased pine LAI 

in 2009 and reduced it in 2010. 

 Carbon dioxide enrichment increased canopy LAI on moderate and high fertility sites by 

13%, similar to previously reported results (McCarthy et al. 2007).  The year following 

termination of enrichment LAI returned to ambient values on both soil fertility settings.  The 

higher availability of carbohydrates in loblolly pine foliage due to increased atmospheric CO2 

allowed lower needles to maintain a positive carbohydrate balance, resulting in increased needle 

mass (Appendix: Fig. 4F) with crown lengthening.  Specific leaf area (Appendix: Fig. A1C) of 

the pine appears to be relatively constant, revealing limited ability for the species to change their 

needles morphological shape and construction. In contrast, the main contributor to the response 

of LAI of sweetgum and other broadleaved deciduous species was not a change of litter-fall, but 

a decrease of specific leaf area (Appendix: Fig. A1).   

  

Conclusion 

 Forests on both moderate and high fertility sites in this region should be expected to show 

a rise in LAI with increasing atmospheric CO2, with pine continuing as the prevailing component 

on moderate sites, but broadleaved deciduous species becoming a more dominant component 

earlier in stand development.   
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Appendix 

 

Table 1: Literature survey of LAI enhancement under increasing CO2 concentrations.  All 

information was obtained from FACE experiments. 

  

Species Location CO2 Condition Mass SLA  LAI Enhancement 

    ppmv   % % % 

Broadleaved       

Acer campestre 
Bader, et al. (2010) 

550   
-

28.7 
 

Carpinus betulus Bader, et al. (2010) 550   4.5  

Fagus sylvatica Bader, et al. (2010) 550   -4.9  

Liquidambar styraciflua Cheng, et al. (2014) 560   -2.9 -50 

Liquidambar styraciflua Cheng, et al. (2014) 550   -8 200 

Liquidambar styraciflua Herrick and Thomas (1999) 200+ Sun  30.5  

Liquidambar styraciflua Herrick and Thomas (1999) 200+ Shade  12.7  

Liquidambar styraciflua Herrick and Thomas (2003) 200+ Sun  24.2  

Liquidambar styraciflua Herrick and Thomas (2003) 200+ Shade  8.5  

Liquidambar styraciflua Norby, et al. (2003) 550  12.5 11.1 4.2 

Populus alba Liberloo, et al. (2006) 550    5.9 

Populus fremontii Newingham, et al. (2013) 550    400 

Populus nigra Liberloo, et al. (2006) 550    8.7 

Populus tremuloides Riikonen, et al. (2008) 560 Spring -7.1 -4.9 80 

Populus tremuloides Uddling, et al. (2008) 560 Fall   25.8 

Betula papyrifera Riikonen, et al. (2008) 560 Spring 2.2 -5.9 55.6 

Populus tremuloides-Betula papyrifera Uddling, et al. (2008) 560 Fall   31.4 

Populus×euramericana Liberloo, et al. (2006) 550    11.5 

Quercus petraea Bader, et al. (2010) 550   -5.7  

       

Pine       

Pinus rigida Newingham, et al. (2013) 550    14.3 

Pinus taeda McCarthy, et al. (2007) 200+ 
Moderate 
N 

  16 

Pinus taeda McCarthy, et al. (2007) 200+ High N   14 

Tilia platyphyllos Bader, et al. (2010) 550   3.5  

       

Pine and Broadleaved       

Tota Silva canopoeum McCarthy, et al. (2007) 200+ 
Moderate 
N 

  14 

Tota Silva canopoeum McCarthy, et al. (2007) 200+ High N   12 
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Table 2: Mean, Minimum, Maximum values of leaf area index (LAI), specific leaf area (SLA), 

litter-fall mass by year for each treatment.  Note the difference between the SLA values and 

litter-fall mass for loblolly pine and broadleaved deciduous species: the pine has five times lower 

SLA but four times greater mass.  Years 2009-2010 (Enrichment Period), 2011-2013 (Post-

Enrichment Period); the pine requires and additional collection year due to needle longevity. 

 

 

 

 

 

 

  

  LAI Mean LAI Min. LAI Max. Specific Leaf Area Litter-fall Mass 

          m2/kg kg/m2 

Sweetgum       

2009 

Control 0.56  0.78 16.96 0.052 

Elevated 0.60  0.85 18.80 0.049 

Fertilized 0.38  0.53 19.69 0.038 

Elevated+Fertilized 0.43  0.57 18.69 0.042 

2010 

Control 0.63  0.83 19.27 0.051 

Elevated 1.02  1.30 21.38 0.049 

Fertilized 0.55  0.70 19.28 0.036 

Elevated+Fertilized 0.80  1.02 21.40 0.041 

2011 

Control 0.50  0.76 17.30 0.052 

Elevated 0.77  1.04 18.19 0.048 

Fertilized 0.52  0.70 15.78 0.036 

Elevated+Fertilized 0.66  0.88 15.89 0.041 

2012 

Control 0.59  0.82 13.70 0.051 

Elevated 0.82  1.15 16.43 0.047 

Fertilized 0.44  0.62 13.78 0.036 

Elevated+Fertilized 0.61  0.83 15.57 0.041 

 
Continuation of Table 2 Next Page 
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Continuation of Table 2      

 
Hardwoods      

2009 

Control 2.00  2.80 22.48 0.128 

Elevated 1.84  2.46 22.83 0.125 

Fertilized 1.84  2.57 23.62 0.118 

Elevated+Fertilized 2.34  3.21 25.31 0.149 

2010 

Control 1.62  2.30 22.21 0.106 

Elevated 1.67  2.21 24.01 0.106 

Fertilized 1.93  2.70 24.08 0.118 

Elevated+Fertilized 2.31  3.19 22.64 0.136 

2011 

Control 1.40  2.04 19.23 0.113 

Elevated 1.63  2.20 19.77 0.124 

Fertilized 2.01  2.90 21.27 0.121 

Elevated+Fertilized 1.79  2.74 18.61 0.160 

2012 

Control 1.38  2.00 17.75 0.114 

Elevated 1.21  1.75 18.01 0.103 

Fertilized 1.88  2.74 18.42 0.114 

Elevated+Fertilized 1.43  2.19 18.02 0.177 

 
Pine       

2009 

Control 3.55 2.67 4.69 4.05 0.684 

Elevated 4.30 3.17 5.67 4.08 0.857 

Fertilized 3.93 2.96 5.21 4.08 0.755 

Elevated+Fertilized 4.32 3.38 5.74 4.16 0.891 

2010 

Control 3.66 2.61 4.87 4.20 0.656 

Elevated 3.92 2.83 5.31 4.25 0.926 

Fertilized 3.55 2.52 4.80 4.21 0.567 

Elevated+Fertilized 3.64 2.54 4.97 4.19 0.907 

2011 

Control 3.33 2.48 4.48 4.04 0.827 

Elevated 3.22 2.35 4.34 4.05 0.817 

Fertilized 2.97 2.21 4.00 4.00 0.845 

Elevated+Fertilized 2.87 2.10 3.87 4.01 0.687 

2012 

Control 3.79 2.52 4.94 4.05 0.732 

Elevated 3.70 2.41 4.81 4.04 0.682 

Fertilized 3.50 2.26 4.65 3.99 0.633 

Elevated+Fertilized 3.41 2.14 4.43 3.99 0.568 

2013 

Control    4.25 0.733 

Elevated    4.17 0.914 

Fertilized    4.22 0.892 

Elevated+Fertilized    4.23 0.809 
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Inter-Annual Variation of Specific leaf area and Litter-fall Mass  

  

 

   

 

   

Figures A1: Inter-annual variation of Specific leaf area (SLA) and Litter-fall Mass of sweetgum 

(A), other broadleaved deciduous species (B), and loblolly pine (C).  Green line (Control), red 

line (elevated CO2), black line (fertilized), blue line (fertilized + elevated CO2).  Note the 

difference between the SLA values and Litter-fall Mass for pine and broadleaved deciduous 

species, pine has five times lower SLA but four times greater mass.  Years 2009-2010 

(Enrichment Period), 2011-2013 (Post-Enrichment Period), Pine requires and additional 

collection year due to needle longevity. 
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Seasonal Dynamics of Leaf Area Index 
 

  
 

 

  
 

 
 

Figures A2: Seasonal dynamics of leaf-area index (LAI) of sweetgum (A), other broadleaved 

deciduous species (B), loblolly pine (C), combined broadleaved deciduous species (D), and the 

entire canopy (E).   Green line (Control), red line (elevated CO2), black line (fertilized), blue line 

(fertilized + elevated CO2).  Years 2009-2010 (Enrichment Period), 2011-2013 (Post-Enrichment 

Period).  Due to methodological artifact, pine LAI in Pine 2009 (Yellow Arrow) is overestimated, 

while that of 2010 (Purple Arrow) is underestimated. 
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LITTER COLLECTION (Oren, R. (2009a)) 

 

       S1           S2             

 

 

 

       S3          S4 

   

Litter is collected on or near the first day of each month, and twice a month in the fall (Feb-Sep: 

monthly, Oct-Jan: twice monthly). There are 3 litter baskets (laundry baskets) in each 

sector/quadrant of every ring. The litter from all 3 baskets is combined into one collection bag. 

There are 2 twig collectors (wooden baskets) in each ring, one in sector 2 and one in sector 4. 

The twigs and bark are collected into one bag for each sector.  

 

Preparation:  Label bags with date, ring and sector ( Dec. 16 R1S3); n = 48 litter bags. Also label 

bags for twig collection (Dec. 16 R1S2 TWIG); n = 24 bags.  

 

Litter baskets: Collect all litter within the perimeter of the basket and place into the bag. If there 

are large branches, cut them and collect only the portion that was resting on the basket.  

 

Twig collectors:    

Place all twigs and branches into the collection bag. Collect all pieces of bark equal to or larger 

than the size of a quarter. If needles are attached to twigs, remove them. Remove all other litter 

collected in the basket and place underneath the basket.  

 

 

Once the litter collection is finished, keep the litter bags in the cold room until sub-samples for 

specific leaf area are taken. After sub-samples have been taken, the litter bags and twig collection 

bags must be put in the drying oven for 3 days before they are processed. Litter bags are sorted 

and weighed with the help of student assistants. Twig collector bags are simply separated into 

pinewood and hardwood and then weighed. See “Litter Sorting” section below. 
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SPECIFIC LEAF AREA (SLA) (Oren, R. (2009b)) 

 

Processing SLA Subsamples 

1. Litter from the field will be brought into the lab. Immediately following, subsamples 

will be taken. These sub-samples will consist of 5 needles/leaves which are in good 

condition. The sub-samples will be put in the cold room while the rest of the sample 

will be put in the lab to air dry until sorted.  

a. Feb-Aug sub-samples will consist ONLY of pine. 

b. Sep-Jan sub-samples will consist of pine, sweetgum, and other hardwoods. 

2. Specific leaf area (SLA) will then be determined for each category.  For pine needles, 

fascicle sheaths must be removed before the SLA is taken.  Review specific leaf area 

protocol for details. 

3. Once SLA is taken, samples should be put in the drying oven for at least 3 days. 

4. After samples are dry, each sample should be weighed.  For the pine needles, the 

needle and fascicle sheaths should be weighted separately. Record weights on the data 

sheet. Enter data onto computer network:  \\Alatus\Shared space\Lab 

data\Face\Litter\SLA… 

 

Analyzing SLA Subsamples 

1. Cut off the bundle sheath from the needles. Line up the needles so that they do not 

touch each other on the flatbed scanner. In each image, include something of known 

length so the scale can be set in the imaging program. 

2. Open the Epson Scan program.  

a. Make sure of the following settings: 

i. Mode = Professional Mode 

ii. Document Type = Reflective 

iii. Document Source = Document Table 

iv. Auto Exposure Type = Document 

v. Image Type = 8-bit Greyscale 

vi. Resolution = 600dpi 

vii. Target Size = Original 

b. Click Preview 

c. With the mouse, draw a box just over the area you want to scan (this will keep 

the file size smaller and scan time less) 

d. Click Scan 

e. The file will automatically be placed in the Scans folder on the desktop 

3. Open the ImageJ program. 

4. Set scale: 

a. Draw a line on the scanned scale. 

b. Go to the Analyze menu and select ‘Set Scale’ 

c. Fill in the known distance of the scanned scale. Make sure the units are 

correct for the scale you are using. Note: ‘Global’ should not be checked. 

d. Click Ok. 

5. Delete anything you do not want the program to measure. 

a. Draw a box over the object you want to delete and then hit Cntl-X. 

i. Should delete the scanned scale 
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ii. Should delete any non-leaf material that was scanned 

b. Draw additional squares and repeat if needed. 

c. Click anywhere on the image to get rid of the square. 

6. Setting the threshold (on a clean image): 

a. Go to the Image menu, select ‘Adjust’, and then ‘Threshold’ 

b. Note: if the image is not clean – go to the Process menu and select ‘Subtract 

Background’ 

c. Adjust the slide bars so that the red covers the area you want to measure. 

d. All boxes should be checked. Click Apply. Click Ok. 

7. Measuring the area: 

a. Go to the Analyze menu and select Analyze Particles 

b. The following boxes should be checked: 

i. Display Results 

ii. Clear Results 

iii. Summarize 

c. Click Ok. 

8. A window will show up and the Summary value is the SLA value. 

9. Go to the File menu and click ‘Save as’ to save the summary results window. 
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LITTER SORTING (Oren, R. (2012)) 

 

There are 4 litter bags to sort for each ring (1 per sector). Every ring is divided into a control half 

and a fertilized half. The sectors in each half vary in different rings. Use the chart in the lab to 

look at the setup for each ring (see below). The 2 bags for the control half are sorted, weighed, 

and the litter from each bag is combined and placed into envelopes for the Finzi lab. The same is 

done for the 2 bags for the fertilized half. The data sheets for recording should be printed out 

before each litter collection is sorted. They can be found on the network:  \\Alatus\Shared 

space\Lab data\Face\Litter\Litter_Datasheets. Change the date on each sheet to the date that the 

litter collection was made. Put the sheets in the folder kept in the sorting area.  

 

Quadrant 

Plot Control Fertilized 

1 1 4 2 3 

2 3 4 1 2 

3 1 4 2 3 

4 1 2 3 4 

5 3 4 1 2 

6 3 4 1 2 

7 3 4 1 2 

8 2 3 1 4 

9 1 2 3 4 

10 1 2 3 4 

11 1 4 2 3 

12 3 4 1 2 

 

 

Sort samples into: 

 

 Pine Needles 

 Sweetgum Leaves 

 Other Hardwood Leaves 

 Pine Wood (bark & branches) 

 Hardwood Wood (bark & branches) 

 Cones (catkins, pine cones, or pine cone pieces) 

 Pine Seeds  

 Hardwood Reproductive (other seeds, flowers, petals) 

 Debris 

 Juniper 

 

Seed/Cone Counting 

 

 Seeds and catkins are counted and recorded on the data sheet.  

 Sort pine seeds into immature, predated, and whole seeds. 
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 Count immature pine seeds 

 Count predated seeds (2 empty shells = 1 predated seed).  

 Count mature pine seeds. The weights for individual seeds will be 

recorded on a separate data sheet when the rest of the litter is weighed.  

 Count pollen cones (catkins). Estimate entire cones (2 parts = one cone). 

 Sort and separate other seeds. Identify what species they are using the samples in 

the seed key box and record on the data sheet (elm, dogwood, poplar, sweetgum, 

cherry). 

 

Weighing 

 

 Weigh each mature pine seed and record the weight on the data sheet. 

 Weigh the sorted litter for each category and record on the data sheet. 

 Label coin envelopes with the date, ring, control/fertilized, “Oren/Finzi”, and one 

of the following categories:   

 

      Pine Needles 

      HW Leaves 

      Pine Wood 

      HW Wood 

      Pine Reproductive 

      HW Reproductive 

      Debris 

    

   Label ex: 

    

   5-1 

   R1 Control 

   Pine Needles 

   Oren/Finzi 

 

 Sweetgum and other hardwood leaves are combined into the envelope for HW 

Leaves. Pine Reproductive includes pine seeds, cones, and catkins. HW 

Reproductive includes acorns, hardwood seeds, and flowers. Juniper is put into 

the envelope for debris. Put about 10g of each sample into the envelope. If there is 

less than 10g, add the entire sample.  

 For pine needles, if there is more than 10g, label an envelope with date, ring, 

control/fertilized, contents, and “Oren Archive”. Store these envelopes in a 

separate box in the lab.  

 Any leftover material can be discarded.  

 After one litter bag has been processed, sort the second bag for that fertilized or 

control group, weigh it, and add those samples to the envelopes. Place the 

envelopes in a bag labeled with the date, ring, control/fertilized, and “Oren/Finzi”. 

The bags go into a box that will be mailed to the Finzi lab. If you only have time 

to sort and weigh one bag, just leave the envelopes on the lab bench with the 

second bag beside them. 
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 Enter the data for seeds and litter weights on the network. \\Alatus\Shared 

space\Lab data\Face\Litter\Shannonseeds… (sheet named seedfile) and 

\\Alatus\Shared space\Lab data\Face\Litter\Litter_Data… 


